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ABSTRACT  

Incorporating technology into the process of writing in an English as a 

Foreign Language setting can aid educators to create an engaging 

learning environment and learners to explore various strategies of 

developing their writing skills. This study was set up to investigate the 

experiences of 28 pre-service language teachers in a Microsoft (MS) 

Word integrated writing course at Farhangian University. Participants 

were selected through convenience sampling. Data were collected 

through semi-structured interviews administered upon completing the 

course, and triangulated via focused group discussions moderated by 

an expert in academic writing. Content analysis of the interviews 

revealed that students expressed favoring an MS Word integrated 

approach with regard to writing skills improvement (through features 

such as spell check, grammar suggestions, thesaurus tools) as well as 

utilizing feedback mechanisms in the Review menu (via track changes 

feature and editing facilities, proofing, and comments), and the 

References menu (via Manage sources and Insert citation features). 

Participants also expressed preferring the on-screen editing activities 

performed in the classroom compared with their previously held 

conventional writing sessions. Implications regarding how MS Word 

can be incorporated into teacher education curricula to improve both 

their academic writing skills and teaching writing through technology-

based instruction are discussed. 
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1. Introduction 
From the advent of the computer, the utilization of the word-processor has become an 

integral part of student writing, profiting specialized teaching programs at colleges 

around the globe. This is where writing specialists admit that learning to write is both 

enjoyable and demanding for learners, and educators have always been looking for 

ways to provide support for novice and professional writers in this regard. Today, many 

documents are reported using word processors, and computerized writing has become 

commonplace in all spheres of knowledge. Language education has not been an 

exception and language teachers have thrived to incorporate this facility into their 

classrooms. In fact, the integration of technological advancements such as the Microsoft 
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word has become a driving force which has transformed and reshaped the ways skills 

are taught and mastered in second and foreign language environments. More 

specifically, English as a Second/ Foreign Language has been one of the fields in which 

the synergy between this technology and language skills instruction is explored. 

Microsoft Word is now introduced as a powerful aid in ESL/EFL classes providing a 

reliable platform that goes far beyond a word processing tool. This multifaceted 

program can be fruitfully utilized in both educating various aspects of writing skills and 

providing feedback to the learners.  

     As this article navigates the intricate area of English as a second/foreign language 

writing enhancement, it illuminates the ways in which MS Word transcends its 

conventional utility, emerging as a dynamic companion in the journey of language 

acquisition. The aim of this study, thus, is to investigate the experiences of EFL pre-

service teachers of an MS Word integrated approach in an Academic Writing class. 

More specifically, to gain a deeper understanding of the students’ experiences, 

participants were inquired whether and in what areas they perceived enhancement in 

their writing skills as a result of being exposed to and engaged in an MS Word 

integrated writing class. The present study, therefore, addressed the following question: 

What are pre-service English teachers’ perceptions of an integration of Microsoft Word 

into a writing skills classroom? 
 

2. Review of Literature 
Studies designed to investigate the effects of Microsoft Word (MS Word) on student 

writing skills have mostly reported positively, implying there are meaningful 

relationships between the use of the technology and students’ scores in composition 

(Berrnhardt et al., 1988; Godsey, 2000; Kurniawan, 2017; Nomass, 2013; Owston et al., 

1992). These studies have focused on different aspects in which the use of MS Word 

can benefit students writing skills such as revision (Daiute, 1986; Owston et al., 1992), 

peer review (Dickenson, 1986; MacArthur, 1988, as cited in Owston, 1991), and self- 

correction (Kurniawan, 2017). Kurniawan(2017) found that students’ errors in subject-

verb agreement, revision of words, and misused vocabulary dropped considerably when 

the students were asked to perform the writing assignments through Microsoft Word 

processing tools. They were even able to self- correct their own papers easily compared 

with those who had completed the tasks by hand (traditional paper- and- pencil 

method). 

     Likewise, Dickenson (1986) reported that the word-processing environment was of 

great help to the students in terms of elements such as the screen display which could 

facilitate peer review and editing. The students were able to share their assignments 

with classmates and use the atmosphere provided by the screen display. Owston et al. 

(1991) endorse the idea that “students' ability to produce reports, newsletters, and 

‘books’ with a polished look for a real audience may promote a perception of writing as 

a meaningful and personally valuable form of communication” (p.250). Moreover, the 

ability to create neat copies of revised text can be regarded a psychological relief for 

those who may be reluctant to showcase their somehow poor writing skills to others, 

including but not limited to the instructor of the classroom. This quality can be regarded 

a transformative force which has the potential to redesign the ways students engage 

themselves into the process of writing in English as a second or foreign language. In 

other words, MS Word may own potentials to be discovered of how it can enhance 

English as a Second/Foreign Language writing skills and strategies and features that 
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learners can use in their quest for linguistic accuracy, fluency, and expressive clarity, 

connection, and conciseness. 

     Contrary to the positive aspects of the integration of MS Word into writing 

classrooms, there have been other studies arguing for the distractions caused by this 

technology. They assert this platform can easily divert students’ attention when they 

need to be cognitively alert to focus on the process of thinking and writing 

simultaneously. Dickenson (1986, as cited in Owston, 1991) points to the “inability of 

the writer to see the entire composition on the screen at one time and the elimination of 

recopying, and thus rereading tasks, [which]may discourage deeper level revisions of 

content and structure” (p.250). The authors believe that novice and lower level writers 

may be hindered cognitively if they are not competent in handling various aspects of the 

software. Owston et al. (1991) believe learning may be blocked by the demanding 

procedures needed for changing, substituting, and revising of the words, sentences, and 

paragraphs. Added to these are poor typing ability (Dalton, 1988), insufficient computer 

literacy, and unfamiliarity with editing processes. 

     In a similar vein, Wedell and Allerheiligen (1991) report that business students who 

took part in their study, did not perceive considerable progress in writing, having used 

the Writer’s Workbench, a famous computer software which was used as a grammar 

checker in the 90s. Participants, however, perceived significant improvement in their 

oral communication skills. 

     Practically speaking, in an age where effective written communication is 

indispensable, the role of technology in language education has expanded far beyond 

mere convenience. At the present time, Microsoft Word emerges as an invaluable aid, 

offering a rich suite of features that cater to the diverse needs of language learners. 

From spell check and grammar correction to thesaurus and synonym suggestions, the 

multifunctional nature of Microsoft Word not only polishes writing mechanics but also 

amplifies vocabulary acquisition and language refinement. This integration of language 

support is particularly revolutionary for second language learners, providing real-time 

feedback and guidance. Moreover, the collaborative and organizational capabilities of 

Microsoft Word break down traditional barriers, fostering an environment in which 

students can engage in interactive writing, peer review, and seamless document sharing. 

These collaborative dimensions not only enrich the learning experience but also emulate 

real-world language usage and communication, nurturing both linguistic and 

interpersonal skills crucial for effective written expression. 
 

3. Methods 
This qualitative study took place in the context of a semester-wide English as a Foreign 

Language writing class at Farhangian University (the main route for training English 

teachers in Iran).  

 

3.1. Context and Participants 

According to the curriculum, the students study Basic English Grammar for two 

subsequent semesters before they are offered Academic Writing courses I and II. 

Conventionally, in Basic Grammar courses, the students are not assigned writing 

paragraph tasks, hence they practice expressing ideas only at sentence level. In 

Academic Writing I and II, longer pieces of writing are assigned and paragraph writing 

is introduced and worked for the first time, along with lessons which orient the students 

with mechanics of academic writing. In other words, students learn how to write single 



 27 Journal of Research in English Language Education   I  Volume 4, Issue 1, August 2025   

paragraphs of various types (i.e., expository, narrative, descriptive, etc.) in Academic 

Writing I, and five-paragraph essays in Academic Writing II, where they learn to 

organize their thoughts in an essay in at least five paragraphs. This study was carried 

out at the conclusion of Academic Writing II (which lasted for twelve 90-minute 

sessions), where the instructor had taught the class how to write, edit, and proofread 

their texts using the word processors available in university’s language lab. Using 

convenient sampling, a total of 28 pre-service EFL teachers (all female), aged between 

21 and 26, agreed to participate in the study.  
 

3-2. Data Collection Procedure 

For this qualitative study, the data preparation consisted of transcription. All the 

participants were asked to recall their experiences of the sessions and describe the class 

and the methodology used by the instructor to utilize the facilities and functions of the 

MS Word. Two roundtable discussions were held in which students expressed their 

opinions about the efficacy of the approach, advantages, disadvantages, and whether 

and in what ways they perceived improvement, if any, in their writing. These 

discussions lasted 30 and 40 minutes and were audio-recorded after students’ consent 

for the recording was received. They were also inquired about their practice at home or 

in the dorm of using their own word processors and evaluating their experiences in 

terms of whether they felt any gains in academic writing. Besides roundtable 

discussions, to reach at an in-depth understanding of the participants’ experiences of 

integrating MS Word into their writing, they were asked to write field notes on the 

advantages/disadvantages of using word processors for writing classes and whether they 

recommended peers or other writing instructors to follow the methodology in future and 

why. They were asked to send their answers to the instructor via email or social media 

platforms. 
 

3-3. Data Analysis 

As the data preparation process used for this study was mainly transcription, a data pool 

was constructed using the transcripts of the roundtable discussions and the field notes 

received from the participants. All the content was reviewed for accuracy and to ensure 

that the audio-recordings and field notes were typed verbatim. Data analysis was carried 

out using conventional content analysis techniques in which the researcher immersed 

herself into the textual content to identify patterns and codes related to the utility of the 

MS Word in a writing class. To determine meaning units, the content was analyzed 

using coding and recoding (Creswell, 2009) in which the transcripts were organized and 

reduced into themes and subthemes. After reviewing, revising, and combining the initial 

codes, major themes and subthemes were identified and were cross checked to make 

sure that themes truly reflect what the respondents had expressed. MAXQDA (version 

2020) software was utilized to content analyze the data and a manual searching 

procedure was applied as a control for the computerized analyses. 

    The next step was determining the trustworthiness of the findings for which two 

experts were asked to review and check the obtained themes and subthemes. Inter-coder 

agreement (Creswell, 2009) was obtained suggesting that the obtained themes and 

propositions were accurately reflecting the participants’ conceptions, feelings, and 

experiences. In addition to raters’ agreement, to ensure the authenticity of the 

interpretations and validity of the findings, a member check procedure (Creswell, 2009) 

was carried out to make sure that the information received was accurate. To this end, the 
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themes and propositions extracted from the texts were returned to the students to check 

the accuracy of the interpretations, and to add, revise, or endorse their intended 

meanings. 

 

4. Results 
Results of the content analysis of the textual data from the roundtable discussions and 

field notes revealed major advantage areas perceived by the students. Generally, all the 

participants expressed positive feelings toward the experience endorsing the idea that 

working with MS Word had an influence on their perception of what a piece of 

academic writing (in this case, an essay) would look like or how writers can manage to 

perform well if they learn to utilize the functions provided in the system. The 

experience was new to all the participants, even those who had already mastered typing 

in their own word processors. One participant (No 6) stated,” I have been using my 

laptop since I was a kid, but I did not know these facilities are present in the Word files 

to help us write better.” Another student (No19) regretted if she knew these facilities 

were installed in her system, she could have acquired a better writing skill. 

     Three major themes and propositions were identified in the data, reflecting various 

aspects of the students’ perceptions of the value of an MS Word integrated approach in 

a writing class: improving writing skills, which was facilitated through some of the MS 

Word features such as spell check, grammar suggestions, thesaurus tools, etc.; 

enhancing individual and peer feedback mechanisms provided by the buttons in the 

Review menu such as track changes feature and editing facilities, proofing, and 

comments; and mastering skills in citation, an integral part of academic writing which 

was practiced via the References menu functions such as Manage sources and Insert 

citation features. 

Table1 

Major advantage areas in the MS Word integrated writing classroom  

Main 

themes 

subthemes Quotations from the textual data 

Writing 

skills  

Improvement of 

spelling power, 

Enhancement of 

vocabulary 

(synonyms/antonyms, 

thesaurus) 

Development of 

mechanics of writing 

(punctuation, 

capitalization, etc.)  

 

My dictation has always been defective making 

me reluctant to write or showcase my writing to 

others. Here I felt more power in writing 

because I could use the spell check which 

spared me more time to think.(S 21) 

Effective 

feedback 

mechanisms  

Individual feedback 

Peer feedback 

Public feedback 

Self- correct 

opportunity 

 

Self-correction was easier when using the 

software. I felt more confidence in my writing 

because using the red/blue lines which 

appeared under the words, I was able to check 

it before everybody else could see it.(S 4) 

Citation 

skills  

In-text citation 

instruction 

Compiling the references in the references 

sections seems to be a challenge. Complying 
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Parenthetical citation 

strategies 

Referencing and 

managing sources 

with the APA standards seem to be a more 

demanding job. But I used the Manage Sources 

function in the References tool and it was OK. 

(Ss 18, 5, & 20) 

 

4.1. Writing skills improvement 

As is shown in Table 1, students expressed gaining confidence in their ability to write as 

a result of applying the software in their writing tasks. One of the areas mentioned in the 

textual data was the spelling accuracy or the ability to form words with correct letters 

using the correct orders. Many participants mentioned that the software has helped them 

improve this skill. “My dictation has always been defective making me reluctant to 

write or showcase my writing to others. Here I felt more power in writing because I 

could use the spell check which spared me more time to think.” (S 21) 

     The type of psychological relief seems to free them from the obstacles inherent in 

traditional writing sittings in which pen and paper are used. This relief would seem to 

spare them sufficient time to focus on more important aspects of writing including but 

not limited to critical thinking. Student 3 believed she felt more freedom when using her 

word processor now that she could spell check and grammar check her text knowing 

that her first draft would be commented by the software. Another participant stated, 

I have always been dependent on my dictionary or Google to find synonyms 

or antonyms or English words for what I had in mind. This would make 

writing a daunting job, discouraging me from even entering an essay writing 

task. I now learn that I can do all of these by a simple right click and use the 

synonym given by the software. (S 15) 

Aside from the options provided by the MS Word in terms of synonyms, translate, and 

thesaurus tools, the software has been helpful in aiding students to reduce their 

grammatical mistakes. One participant expressed satisfaction with the type of help she 

received in this regard. She wrote, “I felt more power in looking up and revising 

pronouns and avoiding unnecessary repetitions, and escaping grammatical mistakes.” (S 

14) In a similar vein, student 12 believed that she was not afraid of writing like before 

as she felt support from the system. She wrote, “I used to hate writing even in my native 

language, Farsi. But using the software gave me fun and courage to start something. The 

facilities are really helpful.” 

 

4.2. Effective feedback mechanisms  

The next major theme extracted from the content analysis of the textual data pertained 

to the students’ perception of how MS Word facilitated feedback mechanisms in their 

writing sessions. They were able to receive not only individual feedback from the word 

processor but also peer feedback provided by their classmates. This advantage came 

through as a result of the instructor’s way of presenting students’ essays on a projector 

so that others could see, comment, and engage in revisions. Student 15 stated, “when 

the essays were shown on the projector, everybody was engaged and we had fun 

because it was kind of collaborative writing. We were all working on the same project 

and I really loved that.” (S 19) 

     Several students expressed positive attitudes towards the feasibility of self-correction 

in the classroom. Students seemed to benefit the red and blue lines under problematic 

words provided by the MS Word. Familiarity with the function of each color was a 

helpful guide for self-correction both while writing and after the act of writing was over. 
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“Grammar suggestions, red and blue lines under certain words, etc. worked as a warning 

for me and made me stop to think more carefully about what I was trying to write,” 

commented student 12.  

     Finally, participants in general showed great enthusiasm towards the facilities 

provided by the Track Changes buttons in the Review Menu of Microsoft Word. They 

could easily revise their text by clicking the Accept or Reject buttons without having to 

rewrite the whole text again, something they would normally do in writing with pen and 

paper. Student 1 perceived this facility “the most interesting aspect of the software”. 

 

4.3. Citation skills development 

The last major theme extracted from the data related with the students’ ability to see 

how citation works and how writers use content from other sources giving credit to 

others’ work. Although the participants were somehow familiar with in-text and 

parenthetical citation techniques from their previous classes or the types of reading 

assignments they had already completed, it was the first time they were required to 

include citations in their essays. Students’ expressions reflected that this newly-required 

technique could be easily handled when they used the functions in the References menu 

tool. One student asserted, “monitoring the organization of the essay I was writing was 

easier and I could easily insert references and citations using the buttons in the system. 

Doing it manually could have been almost impossible for me.” (8) Other participants 

believed handling sources in an APA format could have taken days for them without the 

software, as they would have needed hard work to learn the standards of citation in 

essay and article writing. 

     Regarding the requirements of citation standards, many students perceived the 

assignments challenging. Participant 14 believed she had not learned the technique in 

her native language. She wrote, “this is the first time I see myself writing something 

serious so I need to be careful about all the authors I have used in my text, all the 

publication dates, spaces, periods, parentheses, … they all need thought and attention. 

It’s exhausting! I do not think I can ever do it without the software.”  

     Overall, not all students’ perceptions had a positive perception of implementing MS 

Word in writing classes. Content analyses of the textual data reflected some issues with 

using such a tool in a writing class. First, students complained that the system had not 

been able to guide them through academic writing standards. They believed they needed 

help to distinguish between formal and informal or academic and nonacademic prose, a 

facility not offered by the MS Word system. One participant reported she had difficulty 

checking the options provided by the software in the “synonym” function as she did not 

know the appropriateness of the choices. She believed academic writing was new to her 

and she needed both help in finding suitable words and support in using the words 

appropriately. Participant 20 stated “In spite of the software being equipped with 

grammar checking and mostly usage facilities, it failed to aid us with use 

recommendations, something we, beginner writers need more urgently.” 

     The second issue that emerged from the textual data was that students with various 

writing abilities expressed varying levels of enjoyment. In other words, students with a 

lower writing ability had not presumably been able to utilize the facilities provided by 

the software. More specifically, better writers had used the capabilities more effectively 

and held more positive attitudes towards integrating MS Word into writing classes. In 

other words, more competent writers enjoyed the practice more than other less 

competent writers.  
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5. Discussion  
This paper was an attempt to uncover the English as a Foreign Language pre-service 

teachers’ perception of the advantages and/or disadvantages of integrating the Microsoft 

Word into their writing skills classroom. The overall perceptions of the majority of the 

participants were influenced by the features of the software. In other words, MS Word 
did help the students via features like spell check, grammar suggestions, thesaurus tools, 

synonym, antonym, translate, and smart look up functions. Students in this study had 

apparently gained a kind of autonomy and self-governance over their writing 

assignments. This finding is in line with Kurniawan’s (2017) who reported that 

students’ errors in subject-verb agreement, revision of words, and misused vocabulary 

had dropped considerably when they were asked to perform the writing assignments 

through Microsoft Word processing tools. Moreover, the perceived usefulness of the 

software was triggered by a type of psychological relief created by the kind of support 

the participants received from the software.   

     Celce-Murcia (2001) states that “the goal of every course should be individual 

student progress in writing proficiency, and the goal of the total curriculum should be 

that student writers learn to become informed and independent readers of their own 

texts with the ability to create, revise, and reshape papers to meet the needs of whatever 

writing tasks they are assigned.” (p.215). Elsewhere, she points out that if a writing goal 

is set, spelling tests will be regarded important. The findings of this study are in line 

with this statement and the type of pleasure the students expressed in their notes reveals 

that they have been able to experience individual progress in their writing while at the 

same time being able to practice creativity and independence in writing. This finding is 

in line with the idea of self-correction put forward by Kurniawan (2017). Practically 

speaking, an area in which students could self-correct has been the spelling power 

which not only is facilitated by the software but also as Berkel (2004) notes can itself 

expedite communication and other aspects of the writing process.  

     Other studies have also shown that spelling power enhancement is linked with 

improved communicative and writing abilities (e.g., Blazquez-Carretero and Woore 

,2021; Russak, 2022). This ideal can be easily attained by helping learners improve a 

spelling power in the foreign language while at the same time heading for more 

important communicative abilities to convey ideas in written form. In other words, the 

students can do most of the corrections by a click of the mouse and spare time to more 

thinking on what they are trying to express, knowing that what they have put on the 

paper is being monitored by the machine and checked and edited at the same time, 

before everybody else can find time to comment on it or find fault with it.  

In her book, Teaching English as a Second or Foreign Language, Celce-Murcia (2001) 

comments: 

A [nother] challenge for learners is the fact that most vowels can be spelled 

in many different ways. Learners who are used to a strict sound spelling 

correspondence in their L1 will often be misled by English spelling. For EEL 

learners, who often depend more on the written text than on what they hear, 

this can cause many pronunciation errors. (p. 123) 

The question worth asking here is whether the integration of the MS Word into a 

writing curriculum as such has been able to help learners become informed users and 

independent and creative writers. The answer seems to be positive! The findings of this 

qualitative study revealed that participants’ perceptions were influenced by the type of 
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engagement with the software and the amount of gain and support they received before, 

during, and after the writing process.  

Computer -Assisted Language Learning (CALL) has always been regarded a merit 

in educational settings. According to Naidoo (2020), the usage of digital communication 

technologies and machine applications, as well as teacher and student characteristics, 

expectations, and obstacles, have modified and shaped the global learning environments 

of the twenty-first century.  Kocaman (2022) reported, while computer-assisted writing 

benefits EFL learners, incompetent software use adversely affects the results. According 

to Dalton (1988), some of the factors which may hinder the usefulness of word 

processing in students’ writing are linked with simultaneous attention to writing and 

word processing, inadequate computer literacy, and software weaknesses. 

 

6.Conclusions 
This qualitative study was an investigation into the perceptions of prospective teachers 

of English as a Foreign Language. Data received from roundtable face to face 

discussions along with written field notes showed that all the participants had favored 

the integration of the MS Word into their writing class. However, in line with the 

limited literature in the area, the findings of the present study revealed that the field of 

teaching English as a second or foreign language needs to integrate the facilities 

provided by the word processors in its curricula. Teacher education programs can devise 

strategies to develop MS Word integrated writing classes for novice as well as 

experienced teachers.  To this end, student teachers need to become cognizant with such 

facilities not only to improve their own writing skills but also to help future learners 

explore such capacities in their lifelong learning. This finding shows that the 

implementation of such techniques can work effectively in similar contexts. 

 To sum up, the present study contributes to the small but increasing body of 

literature suggesting that technological advancements like word processors, online 

platforms, social media systems, even AI generating tools can be fruitfully integrated 

into teacher education and K-12 programs to enhance both native and foreign language 

learners’ abilities. For the current study, due to the prearranged classes at Farhangian 

University, the researcher was able to include only female students, as the program is of 

a segregated type. However, to draw more comprehensive conclusions about the type 

and amount of engagement with MS Word, a larger scale study, with both genders will 

be warranted.   
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